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Digital Studio Projects ArtTalk 5

Name ________________________________ Date _________ Class Period _____

For use with Chapter 5

PROJECT 3
STUDIO

Select an original color photograph
that depicts a face.

Scan your photo in grayscale mode
at 300 dpi (dots per inch). Use the scanner
selection tool to crop your image. Cropping
the image focuses attention on the central
image while eliminating distracting details. 

If necessary, save this scanned
image onto a storage device (Zip disk or CD)
to transfer to your computer.

Open the scanned photograph in a
photo editing program. For best results,

equalize your image to increase the overall
contrast of your image. From the Image pull-
down menu, select Equalize, then slide the
bar in the dialogue box to increase the value
contrast. Save your changes. 

Select your image using the Select
All command. Select the Filters menu and
click on the Posterize filter. A dialogue box
will appear that allows you to input the level
and percentage of change that you want.
Make your selection. The number selected
will provide the level of change. The image
window will then preview the image with
posterization applied. Close this box. 

Step 5

Step 4

Step 3

Step 2

Step 1

Objectives
Alter an original photo using a posterization filter in a photo editing program.

Continue experimenting with this image using a traditional print process.

Posterizing Prints 

Special Note: An ordinary photo
can transform into a dramatic image
through the use of the posterization fil-
ter in photo editing programs.This pos-
terizing effect reduces the number of
colors used in the image, and the color
areas increase in size.This is similar to the
way large posters were designed and
printed and to paint-by-numbers pictures.

Original color photograph

Scanner

Computer with photo editing program

Zip disk or CD (optional)

SUPPLIES

Figure 3 Student work.



Examining Your Work

1. Was the photograph you selected an appropriate choice for use with the filters?
Explain.

2. How did the Equalize effect change the image? Did it successfully simplify the
image into lights and darks? 

3. Was a balance of light, middle, and dark values achieved in the posterized
human face?

4. Do the colors selected for each part of the face accurately depict human facial
form? If not, explain why not.

Co
py

rig
ht

 ©
 G

le
nc

oe
/M

cG
ra

w
-H

ill

6 ArtTalk Digital Studio Projects

Your image will change to reveal
light, middle, and dark values. Continue to
work with the filter until you get the results
you desire. If you do not like the change in
the image, you can click Undo in the Edit
menu or use the shortcut keyboard com-
mand Command-Z (Mac OS) or Control-Z
(Windows).

Add colors to your grayscale image
that represent the colors typically seen in a
human face. Select colors from the Fill Color
palette. Select a fill color that is similar in
value; for example, light blue for light gray.
Make note of the percentage of the gray so
that you can use that same gray throughout
your artwork for that color value. 

Changing one fill color at a time
makes it easy to change the color variations
in your image. Using this approach, you can
experiment with various color schemes. You
might try creating a warm or cool mono-
chromatic color scheme for the same image. 

Once you are satisfied with the
outcome, save and print your image.

Use the printed image as a guide
for continuing in the traditional printmaking
process of your choice. Choices include the
linoleum-cut, woodcut, or silk-screen
process. Use reference books or refer to
ArtTalk pages 184–185 and 433 to learn
more about printmaking techniques.

Step 10

Step 9

Step 8

Step 7

Step 6
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Digital Studio Projects ArtTalk 7

Name ________________________________ Date _________ Class Period _____

PROJECT 4

Object or subject to draw

Computer with draw program

Printer 

SUPPLIES

STUDIO

Carefully observe the silhouette or
shape of your object or subject. 

Draw this shape using the Free-
hand or Pencil tool. 

Select a black line and black fill
color for the shape by clicking on black in
the Swatches palette. 

Place this black shape on a white
background, allowing the negative space to
define details of your object or subject.

Carefully look for the details of
your object or subject. 

Select your next color for the line
stroke by first selecting the line stroke and

Step 6

Step 5

Step 4

Step 3

Step 2

Step 1

Objectives
Create an electronic version of a woodcut print. Draw an object or person from

direct observation and explore the layering capabilities of a draw program.

Digital Woodcuts 
For use with Chapter 5

Special Note: Layering shapes using
digital media can simulate the look of a
carved and printed woodcut.This is done
by representing the subject as a black
shape and adding layers of colored details
on top of the black shape.

Understanding the Tools
The Freehand or Pencil tool places anchor points automatically as you draw.You can set the
general preferences for freehand drawing to make the lines smooth or rough. Solid shapes can
be created easily with the Freehand or Pencil tool in a draw program. Shapes are defined by
determined anchor points that, when clicked, are connected by lines.This is similar to connect-
ing the dots in children’s coloring books. Once the shape is completed and closed, it can be
filled with color or a pattern or left empty.

Figure 4 Student work.



Examining Your Work

1. Did the shapes accurately define the subject? If not, what can you do next time to
improve your work?

2. How many details of your object or subject did you depict? 

3. How does your digital drawing simulate the look of a woodcut print?
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8 ArtTalk Digital Studio Projects

then clicking on a color from the Swatches
palette. 

Follow the same procedures for the
fill color. 

Now that your colors are selected,
draw the shapes of your object’s or subject’s
details, one shape at a time. This is similar to
working with cut paper. For example, if a
woman has light yellow highlights in her
brown hair, you have to cut the shape of

each highlight and place it on top, one sec-
tion at a time. 

Position these individual shapes on
top of the black silhouette in their correct
places.

To simulate the carved effect seen
in traditional woodcut techniques, draw the
shapes with a series of zigzag corner points.
Print your final work.

Step 10

Step 9

Step 8

Step 7
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Digital Studio Projects ArtTalk 9

Name ________________________________ Date _________ Class Period _____

PROJECT 5
STUDIO

Brainstorm ideas for an imaginary
company. Decide what type of company it is.
What services does it offer? 

Using a pencil, draw preliminary
ideas for a logo design for the imaginary
company in your sketchbook. A logo is
a symbol that represents a person or a
company. 

Use the letters from the name of
the imaginary company to create the logo.
Sketch these ideas quickly, as the computer
will be used for the final enhancement and
further development of the logo design. 

Open a draw program on the com-
puter. Re-create the design sketches using
the Pencil, Paintbrush, and/or Type tool on
the toolbar. Let your imagination guide you

to more creative solutions, but remember
that logo designs should be readable and
easily understood. 

In combination with the name or
initials, consider the incorporation of sym-
bols of items used in the business. For exam-
ple, you could incorporate a chef’s hat into
the design for a cooking school logo. 

Vary the arrangement of the
words, letters, and symbols. Try different
approaches with the same logo: white letters
on a black background, black letters on a
white background, or a creative combination
of the two. 

Complete your design and save it.
Print the final logo design. 

Step 7

Step 6

Step 5

Step 4

Step 3

Step 2

Step 1

Digital Studio Projects ArtTalk 9

Objectives
Develop a logo as the corporate identity for an imaginary company. Explore the

effective use of positive and negative space in a black-and-white design. Enhance
the logo on the computer.

Name That Company
For use with Chapter 5

Sketchbook and pencil 

Computer with draw or paint program

Printer

SUPPLIES

Special Note: When working for
clients, it is important to understand their
likes and dislikes.Although you may love
your design, it may not meet their needs
or suit their taste.Try numerous ideas to
explore different design styles for your
logo. Figure 5 Student work.
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10 ArtTalk Digital Studio Projects

Examining Your Work

1. Is the logo clearly identifiable?

2. Does the design have bold, crisp, and clean shapes? 

3. Does the logo reflect the line of business it represents?

4. Did you use symbols in your design? If not, why not? Would the use of a symbol
better communicate the nature of the business?





Co
py

rig
ht

 ©
 G

le
nc

oe
/M

cG
ra

w
-H

ill

Digital Studio Projects ArtTalk 11

Name ________________________________ Date _________ Class Period _____

PROJECT 6
STUDIO

Select an art movement or style to
research from the images listed below. They
can be found in ArtTalk on the pages listed.

Rembrandt Harmensz van Rijn, Aristotle
with a Bust of Homer (Figure 5.36, page
124)

Mary Cassatt, Margot in Blue (Figure 6.8,
page 140)

Joan Miró, Landscape (The Hare) (Figure
9.13, page 235)

Jan Vermeer, Girl with the Red Hat (Figure
13.13, page 362)

Paul Cézanne, The Gulf of Marseilles Seen
from L’Estaque (Figure 13.23, page 371)

Paul Gauguin, Faaturuma (Melancholic)
(Figure 13.24, page 372)

Vincent van Gogh, The Starry Night (Figure
13.25, page 373)

René Magritte, The False Mirror (Figure
13.28, page 375)

Roy Lichtenstein, Blam (Figure 13.32,
page 379)

Study the choices above while con-
sidering your life events. Select one of the
masters’ works to use as the springboard for
your digital artwork. 

Create preliminary pencil sketches
in your sketchbook.

Open a draw or paint program.
Select either a horizontal (landscape) or ver-
tical (portrait) format by clicking on Page or
Document Setup in the File menu. Using the
Pencil or Paintbrush tool, draw your portrait
or scene in a new document. Study the mas-
ter’s artwork you selected to determine how
to compose your artwork. 

Step 4

Step 3

Step 2

Step 1

Objective
Reinterpret a great master’s work using digital media to communicate an event

from your own life or create a self-portrait.

If Leonardo Had a Laptop
For use with Chapter 5

Sketchbook and pencil

Computer with paint or draw program

Printer

SUPPLIES

Figure 6 Student work.



Examining Your Work

1. Compare and contrast your digital artwork with the artwork of the master artist
you selected. How are they similar? How are they different?

2. Does your work tell the story you intended? 

3. What about the master’s work inspired you to work in his or her style?
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12 ArtTalk Digital Studio Projects

Special Note:To extend this studio project, use your printed digital image as a source for
a traditional media artwork. Choices could include an acrylic or oil painting, an oil pastel or
watercolor pencil drawing, or a collage or print.

Using a color palette that is similar
to that of the master artist you selected, fill
the shapes in your drawing. Use the Paint
Bucket or Fill tool to fill the shapes with
colors and/or patterns. 

As you work, continue to compare
the master artist’s work to that of your own.

Once you are satisfied, save and print your
final artwork on letter-size paper.

Write an artist’s statement that
compares and contrasts your digital artwork
with the traditional master’s artwork.
Include a statement about how your work
was inspired by the master’s artwork.  

Step 7

Step 6

Step 5
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Name ________________________________ Date _________ Class Period _____

PROJECT 7
STUDIO

Open a new document in a draw
or paint program. Set the document size
to match the size of a standard mouse pad 
(6 by 8 inches). 

Select or create an inspirational
slogan or phrase. 

Select a variety of font styles and
sizes for use in this design.

Type your chosen words or phrase
in a large-size font. Repeat these words until
you have filled the space of the mouse pad.
Try different arrangements of your words.
For example, crowd your letters in some
places to create tension between the positive
and negative spaces. 

Use the rectangular Marquee selec-
tion tool to highlight small sections of the
words or phrase.

Click Invert on the Image pull-
down menu. The colors will change to their
opposites. Black will become white and
white will become black, and so on. If you
do this and do not like the change, click
Undo on the Edit pull-down menu or type
Command-Z (Mac OS) or Control-Z
(Windows). The image will revert back to
the original colors. 

Continue to use the selection tool
to invert parts of the design. Do this until
you are satisfied with the balance of the

Step 7

Step 6

Step 5

Step 4

Step 3

Step 2

Step 1

Objective
Create a mouse-pad design by experimenting with the inversion of positive and

negative shapes and type using a limited palette of colors and values. 

Opposite Effects:
Mouse-Pad DesignFor use with Chapter 5

Computer with draw or paint 
program

Printer

SUPPLIES

Understanding the Tools
The Invert command changes all white pix-
els to black and all black pixels to white.This
effect is similar to photographic negatives.
Invert will also change colors to be the
inverse or opposite of the original color.

Figure 7 Student work.



Examining Your Work

1. Are the words of your slogan or phrase readable? 

2. How effectively did you achieve a balance of the positive and negative shapes? 

3. Were you successful in achieving a balance of colors or values? If not, what
would you do differently next time?
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14 ArtTalk Digital Studio Projects

lights and darks throughout the entire
composition. For a more organic look to
your inverted shapes, use the lasso-shaped
selection tool instead of the rectangular
Marquee tool.

Use the Fill tool to change parts to
another color or value for variety or empha-
sis before you invert the parts. However,

remember to balance the use of the new
color or value by adding it to the arrange-
ment repeatedly to create movement and
unity in your composition.

Try several different layout designs
of the words until you are satisified with the
composition. Save and print your final
design on letter-size paper. 

Step 9
Step 8






